Legal

Copyright © 2010 Evan Sharboneau. All rights reserved. Except as permitted under the United States Copyright Act of 1976, no part of this publication may be reproduced or distributed in any form or by any means, or stored in a database or retrieval system, without the prior written permission of its creator.

This ebook is for personal use only. Do not reproduce, resell, and/or repackage this ebook in any way. All photographs contained in this ebook are copyrighted by the original photographer(s) and have been used with permission or are protected by a Creative Commons License. All images are used for reference purposes only.

Contents contained in this ebook may change and be updated at any time without prior notice.

The author has made every reasonable attempt to achieve accuracy of the content in this ebook, and assumes no responsibility for errors or omissions. The information contained in this document is “as-is” and should only be used as you see fit, and at your own risk.

Any trademarks, service marks, personal names or product names are the property of their respective owners, and are used only for reference. There is no implied sponsorship, affiliation, certification, approval, or endorsement if we use one of these terms.

Rather than put a trademark symbol after every occurrence of a trademarked name, we use names in an editorial fashion only, and to the benefit of the trademark owner, with no intention of infringement of the trademark. Where such designations appear in this book, they have been printed with initial caps.

THIS PRODUCT IS NOT ENDORSED OR SPONSORED BY ADOBE SYSTEMS INCORPORATED, PUBLISHER OF Adobe® Photoshop® software.

Adobe, the Adobe logo, and Adobe Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. All other trademarks are the property of their respective owners.

Adobe product box shot(s) reprinted with permission from Adobe Systems Incorporated.

Front cover image by Dennis Calvert.
# Table of Contents

Forward from the Author ........................................................................................................ 7
Preliminaries ................................................................................................................................ 8
  Camera Bodies .......................................................................................................................... 8
  Lenses ........................................................................................................................................ 9
  Tripods ....................................................................................................................................... 9
  Photoshop ............................................................................................................................... 10

## Module 1: Long Exposure Effects and Light Painting

Long Exposure Effects and Light Painting .............................................................................. 12
  Setting the Shutter speed ........................................................................................................ 12
  Setting the Aperture ............................................................................................................... 14
  Setting the ISO ....................................................................................................................... 15
  Setting the White Balance ....................................................................................................... 16
  Generic Common Settings for Light Paintings: ..................................................................... 17

Fundamental Lights and Techniques ....................................................................................... 18
  Maglights and LEDs ............................................................................................................... 18
    Maglight Review .................................................................................................................. 18
    Key chain LED Review ....................................................................................................... 19
  The Two Styles ...................................................................................................................... 20
  Light Painting ......................................................................................................................... 20
    Light Drawing ..................................................................................................................... 20
  Light Painting ......................................................................................................................... 21
    Using The Fiber Optic Adapter ......................................................................................... 22
    Light Drawing ..................................................................................................................... 23
    Physiograms ....................................................................................................................... 28

Other Light Sources ................................................................................................................ 29
  RGB LED Strips ..................................................................................................................... 29
  Laser Pens .............................................................................................................................. 30
  Fiber Optics ............................................................................................................................ 32
  Glow Sticks and Cathodes ................................................................................................. 34
  Glow in the Dark Paint ........................................................................................................ 34
  Pop-Up Flashes and Off-Camera Flashes ........................................................................... 35
    Flash Gels ............................................................................................................................ 36
  Flash Stencils ........................................................................................................................ 37
    The Classic Stencil Cut-out Method .................................................................................. 37
    The Printer Method ............................................................................................................ 38
  City Lights ............................................................................................................................. 41
  Fire ......................................................................................................................................... 43
    Fire Dancing! ....................................................................................................................... 43
    Sparks ................................................................................................................................... 45
    Sparklers .............................................................................................................................. 45
    Steel Wool (by Chris Reynolds) ....................................................................................... 47
  EL Wire .................................................................................................................................... 50

Light Painting Techniques ..................................................................................................... 52
  Inverting ................................................................................................................................. 52
  Camera tossing and abstracts ............................................................................................. 52
  Lights on wheels and hoops ............................................................................................... 52
  Reflections and mirroring ................................................................................................. 53
  Writing Text ........................................................................................................................... 54
  Combining different lights ............................................................................................... 55
  Creating Orbs ....................................................................................................................... 56
Module 2: Trick Photography and Special Effects

In-Camera Illusions.................................................................85
  Forced Perspective...........................................................85
  Shadow Heart.................................................................87
  Unscrewed Light Bulb Trick...............................................87
  Reflections in Animal Eyes...............................................87
  Monitor Droste...............................................................88
  Reaching into the Monitor...............................................88
  Transparent Screen........................................................89
    Without Photoshop.......................................................89
    With Photoshop........................................................89
  Jowlers.............................................................................89
  Rotated Perspective........................................................90
  Shaped Bokeh...............................................................91
  Double Exposures..........................................................93
    The Orton Effect..........................................................94
  Bi-refrigenence..............................................................95
  Upside-Down Reflections..................................................96

HDR Photography..............................................................97
  Taking the HDR Photograph..............................................99
  Post-Processing in Photomatix..........................................100
  Post-Processing using “Merge to HDR Pro” in Photoshop CS5.........................101
  Manually Tone-Mapping Images.........................................102

Infrared Photography.........................................................105
  Why Take Infrared (IR) Photos?.........................................106
  Can my camera take IR photos?.........................................106
  Taking Infrared Photos Using the Hoya R72 Filter.......................107
    White Balance and Color Correction for Infrared Photography...............108
    Channel-Swapping in Photoshop.......................................109
  IR Examples Chart..........................................................110
Module 3: Photoshop Projects

Introduction to Layer Masks and Blending Modes ................................................................. 145
  Head in the Pot ..................................................................................................................... 146
  Shadow Illusion .................................................................................................................. 149
  Building Window .............................................................................................................. 150
  Bug-Eyed ........................................................................................................................... 150
  Escaping the TV ................................................................................................................ 151
  “Insomnia” ......................................................................................................................... 152

Multiplicity Photography ...................................................................................................... 153
  Taking the Shots ............................................................................................................... 154
  Inside of Photoshop ......................................................................................................... 154

Levitation Photography ........................................................................................................ 156
  Perfecting Shadows .......................................................................................................... 159
  Levitation Photography over Horizons .............................................................................. 164
  Floating Fruit .................................................................................................................... 165

The Invisible Man #1 ............................................................................................................ 167
The Invisible Man #2 ............................................................................................................ 168

Flesh Manipulations ............................................................................................................ 173
  Screaming Head ............................................................................................................... 174
  Blank Head Trick ............................................................................................................. 174
  Using Content-Aware Scaling ......................................................................................... 175

Fake Tilt-Shift Photography ................................................................................................ 176

Mixing Day with Night ........................................................................................................ 178

Recommended Reading ...................................................................................................... 191
Forward from the Author

Hello and thank you for purchasing my Trick Photography and Special Effects ebook! I have created this ebook to share some of the tricks I've learned over the years so that others can get a jump start on getting inspired to create artistic images with photography and Photoshop. This ebook is structured so that at any point in time you can jump to just about any page and start getting inspired with new ideas and techniques. With that being said, however, it wouldn't be a bad idea to read the ebook in order because each technique generally gets more difficult and complex as the ebook progresses.

This ebook wouldn't have been made possible to create without the help from all the photographers who have contributed their images to this project.

Remember that all images in this ebook are hyperlinked to their original location on the internet. This means you can click on any photo in this ebook and it will direct you to the original photo on the web! Feel free to comment the photographer's great work and ask them questions if you want to know more about their image.

If you have any questions, comments, suggestions, testimonials, corrections, new ideas or photos that you would like to see in future editions of this ebook, feel free to e-mail me at trickphotographybook@gmail.com. I'm happy to answer questions and respond to feedback.

You can also find me on YouTube, Flickr, DeviantART, Twitter, and of course my blog/website.

Enjoy!

Evan
Setting the Aperture
The **aperture** is how wide the hole in your lens is. It is very similar to your eyeball's pupil. The bigger the diameter, the more light hits your camera's sensor. So, the bigger the opening, the brighter the image!

For light painting, adjusting the aperture is mostly used for adjusting how bright your light source will appear to be. As we can see in the example above, no other settings were changed in these three photographs except the aperture. The only thing visible at F36 is the streaks of light. When we move down the line to F6, we see that the light streaks are much brighter plus we can see more ambient light around the environment from the original light source.

There is also a side effect that comes with the aperture, and that is called **Depth of Field**. To give an example of what depth of field is, take a look at the two examples below. The one on the left has an aperture opening of F11, and the one on the right has an aperture of 2.8. Sometimes you will hear people refer to the aperture as the “F-Stop” number. It's the same thing.

As you can see, the depth of field determines where your plane of focus is. Using smaller F numbers will make the hole (aperture) in your lens wider, thus making your depth of field more shallow. Using larger F numbers will make the aperture smaller, creating a wider depth of field.
These are called physiograms. How do you create them? Simply tie a string to the end of a flashlight or LED, then attach the other end of the string to the ceiling. A string that is about 0.5-2 meters is fine.

Once your light is dangling from the ceiling, put your camera on the floor facing upward, right underneath the light. Put your camera on manual focus. Turn the room lights off and the Maglight on, give the Maglight a little push, then take your long exposure. I usually stick to 30 seconds.

Sometimes if you are using a wide aperture, the light can spill onto the background. If this happens, you can fix it in Photoshop software by selecting Image > Adjustments > Selective Color and then turning down the blacks so the background is totally black. I would recommend using the lowest ISO possible and then try F8 to F16. More physiogram examples can be found here.

You can also make “compound” physiograms (shown left). This is where you have the string attached to the ceiling in a Y shape, with the light source at the bottom end of the Y.

The Y string will create different patterns that are not just “spirals” like you see above. Try experimenting with different lengths of string on each end (i.e. make the lower half longer, the upper half shorter, etc.) You can also have three or more strings all attaching to the middle string where the light hangs from. Each variation will make a different pattern.
Writing Text
This might seem kind of obvious but it's worth pointing out. LEDs are great for writing letters! Keep in mind that the alphabet picture on the right took a long time to create. Each individual letter took the photographer about 7 attempts each before the final result was compiled in software.
Creating Domes
To create a dome, simply attach a light to the end of a broomstick by using tape or string or something, and then hold one end of the broomstick on the ground while moving the other end of the broomstick around in the air. Think of the end that is on the ground as a pivot point and try not to move it or slide it out-of-place. You can alternatively put a stake in the ground, attach a rope to the end of the stake and a light on the other end of the rope, but I have heard that this is more difficult.
As you can see, the water becomes more defined when the shutter speed gets faster. I can literally see the form of the bubbles and splashes at 1/1000th of a second even though they are still a little blurry. The first six images have a green tint to them because I forgot to set the white balance to compensate for the ND8 filter I was using. The speed of flow also plays a roll on how smooth the water will look.
**Shaped Bokeh**

Even though the classic *bokeh look* of big bold blotchy circles in the background of an image made with lenses with shallow depth of field is still very appealing and pleasing to the eye, *shaped* bokeh takes it to a whole new level! If you really want to emphasize a certain theme in your photograph, this is an excellent way to do it. Not too many people take the time to do this stuff, so your photos will really stand out against the crowd.

Cut out a small shape onto construction paper (black is technically the best because it reflects the least amount of light, but anything works) and tape it over a lens that has shallow depth of field. The hole should be about the size of one of your fingernails, if not smaller. The standard bokeh lens that most people have is the **50mm f1.8**. It's an inexpensive yet very high quality lens.
Taking the HDR Photograph

**Step 1: Put your camera on a tripod.** HDR images are ideal when they have been taken on a tripod. If you can hold your camera really steady, then you could theoretically take the bracketed set of images without a tripod, but I always advise against this because the results are less than perfect.

**Step 2: Put your camera in Aperture Priority mode.** Because we are taking 2 or more photographs and then combining them, the images must remain consistent in terms of focus and aperture. Also, put your ISO down to as low as it can go (ISO 200 or lower) and put your white balance to something other than Auto.

**Step 3: Manual Focus.** Focus as you would normally then turn off automatic focusing in order to ensure that the lens doesn't try to focus on something else when you're taking the other exposures. I've found that this usually works fine with auto-focus left on, but if you are a perfectionist, switching over to manual is ideal.

**Step 3: Take the bracketed set of photos.** In order to take a set of bracketed photos, please refer to your cameras manual, or Google the term “auto bracketing” and then “your camera model” (example: auto bracketing D50) and you will find your answer. Not all cameras are capable of bracketing photos. If this is the case for you, you will need to manually take a bracketed set of images by adjusting the shutter speed. Every camera is different, so I can't advise on this part. Some cameras have buttons that allow you to bracket your images, and some cameras only allow it through the menu.

You can take as much or as little images as you want. A standard quick HDR photo consists of one photograph that is 2 stops underexposed, one photograph that is perfectly exposed, and one photograph that is overexposed by 2 stops. This makes a bracketed set of (-2, 0, +2). You can even take more if you wish, like a (-4, -3, -2, -1, 0, +1, +2, +3, +4) or a (-4, -2, 0, +2, +4), but not all cameras can automatically take that many, so you may need to do it manually by adjusting the shutter speed for each individual exposure you take.

*Note: Pushing down on the shutter button causes minor camera-shake. In order to get around this camera-shake issue and get images that are truly tack sharp, use a cable release, or better yet, a wireless remote with mirror lock-up on (if your camera has that feature).*

You can, alternatively, just take a single RAW photo without taking a bracketed set of images. I would only do this when there are moving subjects (people, animals, cars, etc.) in your composition because moving subjects can't be recorded properly across three separate frames. If you do end up taking a bracketed set of images and there are moving subjects in it, there are ghosting removal tools available in both CS5 and Photomatix.
White Balance and Color Correction for Infrared Photography

After taking some photographs with your filter, you may realize that your pictures are completely red (or pink, or purple). In order to fix this, just set the White Balance with your filter on, pointing the camera at green grass. Google search "How to set white balance with [YOUR CAMERA MODEL]" for instructions if you don't know how to do this yet. If it works, your colors should look like the ones in the photo below. Brown skies and blue foliage.

![Brown skies and blue foliage](image)

However, some cameras cannot set extreme infrared white balances in-camera and your photos will come out with weird red and purple colors no matter what. If you find that this is the case for you, set your white balance to the coolest color temperature available (2500K or lower if you can manually have a numerical white balance, or Incandescent/Tungsten if you can't set a numerical value). Then fix the color later in post processing. There are three ways to do this:

1. If you are shooting in JPEG, bring the photo into Photoshop and click *Image > Auto-Color*. The photo will then fix itself. Clicking *Auto-Contrast* (or *Auto-Levels*) also helps make the image more dynamic.

2. If you are shooting in RAW, drag and drop the photo into Photoshop. The RAW image will automatically be opened up in the Adobe Camera RAW dialog box. Drag the Temperature slider all the way to the left (2000), and the Tint slider to -100. Now open your image in Photoshop (bottom right corner of the ACR dialog box). Done. More information/troubleshooting can be found [here](#).

3. If you are shooting in RAW but do not have Photoshop, set the WB with a program called UFRAW. This method should work with any camera. Download UFRaw, install it, open an image with it, then go into the White balance tab (it's the first one on the left) and select “Auto WB” in the drop-down box. Click the save tab (2nd to the last tab, make sure JPEG is selected, then hit the save button in the bottom right corner of the window).
Creative 360x180 Compositions

360x180 panoramas are extravagant by themselves, but when you have an eye that looks for composition, you can get even better results. A lot of it comes down to experimentation, but there are some compositions that will guarantee spectacular results.

Working with Trees

A beautiful technique to use is to stand about 10-20 feet from a large tree (preferably with no other trees around the horizon or anywhere else) and then take a 360x180 panorama. Once you project it to stereographic form and move some sliders around in Flexify to make it a tunnel, the composition can come out beautiful.

Another interesting composition technique you can use with trees is to stand about 3-10 feet close to a tree that has many overhead branches. This blocks out the boring bland sky and fills it in with the branches from the tree.

It's best when the tree has really widespread branches. I happen to have two areas like this on my property. The orange image on the right was taken in October while I was standing between two trees with widespread branches. The image below the one on the right was taken in my backyard during summer. The branches were somewhat low to the ground but also widespread, making the entire frame filled in with leaves.
The Harris Shutter Effect

In order to get this effect we will have to use Photoshop's channels tab.

Step 1: Put your camera on a tripod to make sure it is in the same physical location in 3D space.

Step 2: Take three (or more or less, depending on what you want) photographs of a person, animal, or object in a different position around the frame.

Step 3: Place all three photos into one Photoshop document as three separate layers.

Step 4: Copy either the entire RGB layer or a single, red, green, or blue channel by clicking on the channels tab, and then replace one of the red, green, or blue channels onto the bottom layer. You'll need to do this twice if you want three color variations of your subject. After you have pasted the layers into a channel, your channels pallet should look like the one below.

Note: If you can't find the Channels pallet, just click Window > Channels.

The photograph will render normal color in areas that remain stationary throughout each of the three photos. The example on the right is an elevator. The camera was placed on one of the steps so that the steps are in the same position but the environment around the steps are in motion. Pretty funky huh?

More resources on this effect can be found here:
http://en.wikipedia.org/wiki/Harris_Shutter
http://www.flickr.com/groups/harrisshuttereffect/
There is a popular composition that many female self-portraitists seem to use on Flickr, and that is to wear a dress that hangs down underneath their body. The composition is very aesthetic and adds more realism to the shot. Search “levitation” on Flickr to see more.
Floating Fruit
This can be done with a blank background which will only require one shot, or you can have a complex background which will require one shot of the fruit plus another shot of just the background. This is the same technique used in the invisible man.

Setting up the Shot
I don't have the original photographs for this image but I can still explain how I created it in my studio. I had a white sheet hanging down from the ceiling about 1 foot in front of the wall with an external flash resting on the floor behind it, facing upward with an optical slave attached to the flash and another light (the main light) to light up the front of the subject. Then the main light bounced off the wall and back onto the banana to light it up (click the “my studio” link above to visually see what I am describing) which also triggered the optical slave to fire off the flash behind the bed sheet. The plate was resting on a separate white sheet on a stool.

Taking the Shot
But how did I make the banana pieces float in mid air? I cut the banana into separate pieces and then slid a shish kabob stick in the middle of the banana (be careful because the banana pieces can and will break apart). In order to make the entire thing float in mid air, I had an assistant carefully hold the base of the banana on its edges and the top of the shish kabob stick. We went through 2-3 bananas until we got it right. We had to experiment with different kinds of sticks until one worked. Pencils, pens, small sticks, and toothpicks to not work with bananas.

In Photoshop
I made everything a little bit brighter by using the Dodge tool (I wanted everything to blasting white) and then simply took a white paint brush and painted over the shish kabob stick to get rid of it. I used the Clone Stamp tool to remove any shish kabob stick that was remaining on the actual banana pieces.
8. To get rid of the neck inside of the shirt, grab the Pen tool and make a selection around the hole with a feather radius of .3, hit OK, then push the delete key.

9. Grab the Clone Stamp Tool and ALT+Click on an area on his shirt, then click inside of the area inside of the selection and fill it in.

10. If you want to add some shading to make it look more realistic, grab the Gradient tool (click and hold your mouse over the paint bucket icon and it will appear), then go to the top and select the Radial Gradient icon. Set the Mode to either Overlay or Multiply and reduce the Opacity to 5%-20%, then click and hold your mouse in the center of the selection and drag your cursor to the edge of the selection, you will now see some shadow. Deselect the selection by right clicking inside of it and then clicking Deselect.

And that's all there is to it. Use the same method on the end of the sleeves and the shorts. Remember to use the Clone Stamp Tool to fill in any areas where the leg/arm is in front of the body.